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Overview
Introduction

Cisco Quality Management (QM) Desktop enables managers, supervisors, agents, 
knowledge workers, archive users, and evaluators to use the same application to 
monitor and evaluate the performance of groups, teams, and individual agents in 
a contact center environment. 

QM Desktop provides summaries and details of the results of agent evaluations 
on a group, team, and individual agent basis in the QM Desktop dashboard. Your 
assigned role gives you access to varying levels of information. Evaluators, 
managers, and supervisors can actually evaluate a contact, view evaluation 
results, and enter comments on an evaluation; agents can view and comment on 
their own evaluation results.

All roles except evaluators and archive users can view historical reports that 
display data for a specified time period selected by the user. The time period can 
be from one day to up to a year from the current date. 

If archiving is enabled, managers, supervisors, and archive users have access to 
archive audio recordings. Managers can access the recordings for their assigned 
groups, and supervisors can access the recordings for their assigned teams. 
Archive users can access all recordings.

Audio recordings can be archived for any length of time as configured by the 
administrator. Archived recordings can also be exported to any desired location 
on a recording-by-recording basis.

What’s New In This Version

QM Desktop 2.6 includes the following new features:

■ User-defined and editable metadata associated with recordings

■ Support for dual-monitor recordings

■ Maintain the aspect ratios (4:3 and 16:9) of video recordings
7
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■ Ability to view the entire video recording in the playback window or zoom in to 
a 1 to 1 resolution to view recordings full size

■ If configured by the administrator, users can export contact recordings within 
their scope and their associated metadata as WMV, WMA, and WAV files

■ If configured by the administrator, evaluations using specified evaluation 
forms can require approval by managers, supervisors, and/or evaluators

■ Contact evaluations can be saved in progress

■ QM Desktop can be configured to timeout after a specified idle time

■ All segments of a call through a contact center can be played back so that the 
user can review the entire call
8 September 2008



QM Desktop Feature Levels
QM Desktop Feature Levels

There are two feature levels of QM Desktop: Basic and Advanced. 

■ At the Basic feature level, contact recordings are audio only. 

■ At the Advanced feature level, contact recordings are both audio and video. 
September 2008 9
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Logging In

QM Desktop requires a user name and password in order to log in. Only one instance 
of QM Desktop can run at a time on your PC.

You will not be able to log in if:

■ You are not a licensed QM user

■ The license has expired

■ You are a manager who is deactivated or not assigned to a group

■ You are a supervisor who is deactivated or not assigned to a team

■ You are an evaluator and there are no active groups

To log into QM Desktop:

1. If QM Desktop is not open on your desktop, click Start > All Programs > Cisco 
> WFO > Quality Management Desktop. 

If QM Desktop is open on your desktop, choose File > Login from the menu 
bar. 

QM Desktop starts and the Login dialog box appears (Figure 1). 

2. If your system uses Windows Active Directory, enter your Windows user name, 
password (the password is case-sensitive), and domain (in the Log On To 
field). 

If your system does not use Windows Active Directory, enter your Windows 
user name and your QM password. This password is set up in QM 
Administrator for you by your administrator.

3. Click OK.

Figure 1. Login dialog box (Active Directory system)

The Log On To field 
appears only in systems 
that use Windows Active 
Directory. It contains the 
name of the domain you 
are logging on to.
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Logging In
You are now logged into QM Desktop. 

Which view you see depends on your role:

■ Agents, knowledge workers, supervisors, and managers see the QM 
Desktop dashboard

■ Evaluators see the Recording view

■ Archive users see the Archive view

NOTE:  If you are assigned multiple roles within QM, you are 
logged in at the highest role level. For example, if you are 
assigned as both an evaluator and a manager, you are logged in 
at the manager role level. You can change roles within QM after 
you are logged in. See "Changing Your Role" on page 13. 
September 2008 11
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Automated Updates

QM can be configured to enable automated updates. This means that whenever a 
newer version of QM is installed on the servers, all instances of the client applications 
(QM Administrator, QM Desktop, and QM Desktop Recording) will also be updated the 
next time they are started. 

When automated updates are enabled, every time you start QM Desktop it checks to 
see if there is an updated version available. If there is, it automatically runs the 
update process. 

NOTE:  If the automated update process is running, do not attempt to 
start any of the QM desktop applications, or another instance of the 
automated update process may start.

When the automatic updating process occurs you will see a dialog box notifying you 
that your instance of QM Desktop will be updated. Click OK and then follow the 
instructions in the installation wizard that follows.

When the update is finished, you will see a final dialog box telling you that your update 
is complete. Click OK, and then restart QM Desktop and log in as usual.

NOTE:  If you cancel an update, the update will fail. However, you will 
still see a message that the upgrade has completed. The next time 
you start QM Desktop, the automated update process will run again.
12 September 2008
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Changing Your Role

If you have been assigned to multiple roles within QM (for instance, if you are both an 
evaluator and a manager), you automatically log into QM Desktop at the highest role 
level. Your current role is indicated in the upper right portion of the QM Desktop 
window (Figure 2).

To access the functions appropriate to your multiple roles, you must change from one 
role to the other from within QM Desktop.

To change your role:

1. From the menu bar, choose Settings > Change Role or View.

The Change Role or View dialog box appears (Figure 3). 

2. From the drop-down list, select the desired role and then click OK.

NOTE:  If the role you are changing to does not have a choice of views, 
the View field is disabled.

QM Desktop now displays information appropriate to the new role. 

Figure 2. Your role is displayed in the right corner of the QM Desktop window

Figure 3. Changing your role
September 2008 13
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Changing Your View

The QM Desktop dashboard displays one team’s or one group’s information at a time. 
However, supervisors can be assigned to multiple teams, and managers can be 
assigned to multiple groups. To access the information for another team or group, you 
must change your view.

You can change your view only from the Dashboard tab. 

To change your view:

1. From the menu bar, choose Settings > Change Role or View.

The Change Role or View dialog box appears (Figure 4). The View field is 
enabled only if your role is Manager or Supervisor.

2. From the View drop-down list, select the desired view and then click OK.

The dashboard now displays information appropriate to the team or group 
selected. 

Figure 4. Changing your view
14 September 2008



Logging Out
Logging Out

You can log out of QM Desktop two ways:

■ Log out and exit (close) the application

■ Log out and leave the application open

NOTE:  Closing QM Desktop (using the procedure below or by clicking 
the Close button in the upper right corner of the window) 
automatically logs you out of the system. 

The administrator can configure QM Desktop so that after a specified amount of idle 
time, it automatically times out your session. You are logged out and the application is 
left open. By default, this feature is not enabled.

NOTE:  If you are in the process of exporting a recording when QM 
Desktop times out, the export will continue but all progress windows 
are closed.

To log out and exit QM Desktop:

■ From the menu bar, choose File > Exit.

You are logged out of QM Desktop and the application closes.

To log out and leave QM Desktop running:

1. From the menu bar, choose File > Logout.

A confirmation dialog box appears.

2. Click OK to confirm you want to log out.

You are logged out of QM Desktop but the application remains open.
September 2008 15
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The QM Desktop Interface
Introduction

QM Desktop displays information on tabs. Which tabs you see and the level of 
information presented on the tabs depends on your role, as shown in Table 1. 

NOTE:  The Evaluation view is a window accessed by choosing a 
recording on the Recordings tab.

NOTE:  Supervisors and managers can evaluate contacts only if 
that feature is enabled by an administrator in QM Administrator.

Scoping Rules

Your role not only controls what information is available to you, but also the scope 
of that information. In this case, “scope” refers to the contacts you can view 
and/or evaluate.

Scoping Rules and HR/Training Recordings.  The scoping rules described in this 
section do not apply to contacts tagged as Training recordings, which can be 
reviewed by all roles. The scoping rules do apply to all other recordings, including 
those tagged as HR recordings. 

Table 1. QM Desktop display tabs per user role

Tab Evaluator Agent
Knowledge 

Worker Supervisor Manager
Archive 

User

Dashboard × × × ×

Recordings × × × × ×

Evaluation × × × × ×

Archives × × × ×

Reports × × × ×
17
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Managers

Managers can view contacts made only by their currently active groups. For example, 
if a manager had been assigned to Group A last week, but is now assigned to Group B, 
that manager can view only contacts recorded by currently active agents on currently 
active teams in Group B. This includes contacts recorded by the Group B agents 
before the manager was assigned to Group B. Managers can also view training and 
HR contacts.

Supervisors

Supervisors can view contacts made only by their currently active teams. For example, 
if a supervisor had been assigned to Team A last week, but is now assigned to Team 
B, that supervisor can view only contacts recorded by currently active agents on Team 
B. This includes contacts recorded by the Team B agents before the supervisor was 
assigned to Team B.

Evaluators

Evaluators can view contacts for all currently active groups, teams, and agents. They 
cannot see any contacts made by deactivated groups, teams, and agents.

Archive Users

Archive users can view all archive contacts made by all active and inactive groups, 
teams, and agents.

Agents and Knowledge Workers

Agents and knowledge workers can view only their own contacts. 

Scoping Differences Between Dashboard and Reports

The QM dashboard and QM reports display information based on date ranges, roles, 
and organizational changes. Each displays the data in a slightly different way. Table 2 
summarizes how the values reported are different, based on where the information is 
viewed.

Table 2. Scoping Differences Between Dashboard and Reports Data 

Information 
Type Dashboard Reports

Date ranges Displays only completed 
months. For example, the Past 
Month is the last completed 
month.

Uses explicit date ranges 
selected by the user.
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Roles Displays data based on the 
current role.

For managers and supervisors, 
the reports available are based 
on the current role. The 
groups, teams, and agents 
that are available for selection 
are based on the groups or 
teams that are currently 
managed or supervised, and 
which agents are currently on 
those teams.

Content and 
calculations

Calculations and totals are 
based on the current role. For 
example, to calculate a group’s 
current average, all agents 
currently in the group and all 
their contacts are calculated 
into the average, whether or 
not they were in this group 
when those contacts occurred.

Calculations, totals and the 
contents of each report are 
based on historical 
configurations. For example, to 
calculate a group’s historical 
average for a specified time 
period, all contacts that 
occurred for any agent that 
was on the team at any point 
in the time range are 
calculated into the group 
average for that time period. 
Note that if an agent was just 
added to the group, but all of 
the agent’s contacts occurred 
before the agent was added, 
none of those contacts are 
calculated in the group 
average.

Organizational 
changes

Displays data based on the 
current organizational 
structure. For example, an 
agent that was recently 
removed from a supervisor’s 
team will not appear in that 
supervisor’s data.

Displays data based on the 
historical structure. For 
example, an agent will appear 
on a supervisor’s team in a 
report if the agent was present 
on that team during the 
selected date range.

Table 2. Scoping Differences Between Dashboard and Reports Data — Continued

Information 
Type Dashboard Reports
September 2008 19
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Time Zones

QM Desktop displays time in two different ways, depending on where it is displayed.

Time in the QM Desktop Interface

In the QM Desktop interface, the time associated with a contact is the time the 
contact occurred at the agent’s location, expressed in a format appropriate to the 
locale. For example, if the agent is located in Chicago, the time associated with any 
contacts made by that agent is Chicago local time. 

The contact also displays the abbreviation for the local time zone. If the time zone 
associated with the contact is unknown to QM Desktop, then the time is displayed in 
Greenwich Mean Time (GMT). 

Time in QM Desktop Reports

In QM Desktop reports that involve single agents, the time associated with a contact is 
the time the contact occurred at the agent’s location in a format appropriate to the 
locale, with no time zone designated. 

In reports that involve multiple agents, the time associated with a contact is in a 
format appropriate to the locale plus the GMT offset. For example, the time for a 
contact made by a Chicago agent at 3:42 PM (Chicago time) is displayed as 9:42 PM 
GMT -06:00.
20 September 2008
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Dashboard Tab

The dashboard tab (Figure 5) provides a summary and detail display of the contact 
center’s performance statistics for the last twelve months. The summary displays are 
in the form of bar charts and graphs. 

There is a standard set of statistics displayed in the dashboard, but the level at which 
the statistics are presented depends on your role as agent, knowledge worker, 
supervisor, or manager.

The upper half of the dashboard displays statistics in graphical form, either a bar 
chart (for the Evaluation Totals and Contact Totals) or a line chart (for the Quality 
Averages). The charted statistics are:

■ Evaluation Totals (Total Exceed/Total Meet/Total Below)

■ Contact Totals (total QM recordings/total evaluations)

■ Quality Averages (Group/Team/Agent averages)

The default graph for all roles is the Quality Averages. The default time frame for this 
graph is 4 months (current month plus past 3 months). Otherwise, the graphs span 12 
months (current month plus 11 past months).

Figure 5. Dashboard tab for a manager, Evaluation Totals chart shown
September 2008 21



Quality Management Desktop User Guide
Summary Statistics

The statistics displayed in the summary pane are described in Table 3. Different roles 
see different statistics, as noted in the table.

NOTE:  Any statistics concerning scored contacts do not include 
evaluations in progress or evaluations awaiting approval.

Table 3. Dashboard Summary Statistics 

Statistic Viewed By Description

Group Average All The average score of current group members’ 
contacts during a specified time period, 
expressed as a percentage.

Team Average Agent 
Supervisor

The average score of current team members’ 
contacts during a specified time period, 
expressed as a percentage.

Agent Average Agent The average score of the agent’s contacts 
during a specified time period, expressed as a 
percentage. 

Total Evaluations All The total number of contacts that were 
evaluated during the time period.

Total Exceed All The total number of evaluated contacts whose 
scores exceed expectations. The default score 
range is 90–100%. This range can be modified 
by the administrator.

Total Meet All The total number of evaluated contacts whose 
scores meet expectations. The default score 
range is 75–89%. This range can be modified 
by the administrator.

Total Below All The total number of evaluated contacts whose 
scores fall below expectations. The default 
score range is 0–74%. This range can be 
modified by the administrator.

Total QM 
Recordings

All Total number of scored and unscored quality 
management recordings made for the group, 
team, or agent (depending on the role 
displayed) during the time period.
22 September 2008
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The time periods displayed in the summary pane are described in Table 4. Each 
column header in the summary pane displays a tool tip that shows the specific time 
period covered by that column.

Detail Statistics

The statistics displayed in the detail pane are described in Table 5. Different roles see 
different statistics, as noted in the table. You select the time frame for the statistics 
from a drop-down list. Your choices are:

■ Current month

■ Past month

■ Past 3 months

■ Past 12 months

NOTE:  Any statistics concerning scored contacts do not include 
evaluations in progress or evaluations awaiting approval.

Table 4. Dashboard Summary Time Periods 

Time Period Description

Current Month The current calendar month. 

Past Month The past calendar month.

Past 3 Months The past three calendar months.

Past 12 Months The past twelve calendar months.
September 2008 23
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Table 5. Dashboard Detail Statistics 

Statistic Viewed By Description

% Score Agent The percent score given to the agent’s 
contact by an evaluator.

Agent Supervisor The agent’s name.

Agent Average Supervisor The average score the agent has earned in 
the selected time period.

Agent ID Supervisor The agent’s ID.

Below Agent An X indicates that this evaluation falls 
below expectations.

Date Agent The date of the contact.

Duration Agent The duration of the contact.

Exceeds Agent An X indicates that this evaluation exceeds 
expectations.

Meets Agent An X indicates that this evaluation meets 
expectations.

Score Std Dev Supervisor 
Manager

The standard deviation of the agent’s 
score. A low standard deviation (closer to 
0) indicates that scores are grouped 
closely to the mean score. A higher 
standard deviation (further from 0) 
indicates that scores are far from the 
mean. A lower standard deviation is an 
indicator of consistent performance; a 
higher standard deviation is an indicator of 
variable performance.

Team Manager The team name.

Team Average Manager The average score the team has earned in 
the selected time period.

Team ID Manager The team’s ID.

Total Below Supervisor 
Manager

The total number of evaluated contacts 
whose scores fall below expectations. The 
default score range is 0–74%. This range 
can be modified by the administrator.

Total Evaluations Supervisor 
Manager

The total number of evaluations the agent 
has had in the selected time period.
24 September 2008
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Total Exceed Supervisor 
Manager

The total number of evaluated contacts 
whose scores exceed expectations. The 
default score range is 90–100%. This 
range can be modified by the 
administrator.

Total Meet Supervisor 
Manager

The total number of evaluated contacts 
whose scores meet expectations. The 
default score range is 75–89%. This range 
can be modified by the administrator.

Table 5. Dashboard Detail Statistics — Continued

Statistic Viewed By Description
September 2008 25
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Recordings Tab

The recordings tab (Figure 6) enables you to review a list of recorded contacts, and 
from this list access the associated evaluations. It displays a table containing a list of 
recorded contacts based on the node you select in the navigation tree. 

The recorded contacts displayed in the Contact view depends on your role:

■ Evaluators see all active agents’ contacts (scored, unscored, in progress, 
needs approval)

■ Managers see their current groups’ contacts (scored, unscored, in progress, 
needs approval)

■ Supervisors see their current teams’ contacts (scored, unscored, in progress, 
needs approval)

■ Agents and knowledge workers see only their own scored contacts

You can view a selected contact’s associated contacts by clicking the Associated 
Contacts button. When you do this, you are switched to the Archives tab. See "Playing 
All Segments of a Call" on page 47 for more information on associated contacts.

Figure 6. Recordings tab for a manager
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Recordings Tab
The administrator configures the minimum length of what is considered a valid 
recording for evaluating contacts. Any recording that is shorter than that minimum will 
not appear in QM. 

The Contacts pane can display a maximum of 6,000 contacts in response to any 
query. If your query returns more than 6,000 contacts, you are prompted to narrow 
your search criteria.

Table 6 describes the fields displayed on the Recording tab. In addition to these 
standard fields, if user-defined metadata is associated with the recording, those fields 
will also be displayed.

Table 6. Recording Tab Fields 

Field Viewed By Description

%Score All The score given to the contact.

Call Duration All The duration of the contact.

Called Number All The number of the phone that received the 
call.

Calling Number All The number of the phone that made the call. 
Displays “unknown” if the calling number is 
unlisted or blocked.

Date All The contact date.

First Name Manager 
Supervisor 
Evaluator

The agent’s first name.

Group Manager 
Evaluator

The name of the group.

HR Manager 
Supervisor 
Evaluator

Yes/No. The contact has been tagged as an 
HR contact.

Id All The contact’s ID.

Last Name Manager 
Supervisor 
Evaluator

The agent’s last name.

Reason Manager 
Supervisor 
Evaluator

The reason the contact was recorded as set in 
the recording rule (First, Last, Longest, 
Shortest, Random, Logging, Tagged, 
Performance, and New Employee).
September 2008 27
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Sorting Recordings

Recordings in the navigation tree can be sorted in a number of ways, selected from 
the drop-down list at the top of the tree. You can choose to sort them by:

■ Organization

■ Date

■ HR tag and then organization

■ HR tag and then date

■ Training tag and then organization

■ Training tag and then date

Recording Retention

The length of time recordings are kept is set up by the QM administrator. QM allows 
recordings to be retained according to the limits shown in Table 7.

Team Name Manager 
Supervisor 
Evaluator

The name of the team.

Time All The contact time.

Training All Yes/No. The contact has been tagged as a 
training contact.

Zone Manager 
Supervisor 
Evaluator

The time zone where the contact was 
recorded.

Table 6. Recording Tab Fields — Continued

Field Viewed By Description

Table 7. Recording retention periods 

Recording Type Retention Period

Unscored, In Progress, Scored, 
Needs Approval

10–60 days

HR-tagged 2–12 months

Training-tagged 2 months–Indefinitely

Archived, Agent-tagged 12 months–Indefinitely
28 September 2008



Recordings Tab
Evaluation View

The Evaluation View window (Figure 7) is displayed when you select a specific 
recording from the Contacts window. 

For information on how to evaluate a contact, see "Evaluating Contacts" on page 51.

Parts of the Evaluation View Window

The Evaluation View window is divided into 8 sections (Figure 7).

■ Recording Selection tree—Use this to sort contacts by organization, date, or 
tag, and then double-click the desired contact to display it in the Contact 
Evaluation window.

■ Playback pane—(Advanced only) Contact screen recordings are played back in 
this viewing pane.

■ Playback Controls—Use these buttons to play back, pause, and control the 
volume of a recorded contact. This section also includes a recording progress 
bar (slider), which can be used to quickly skip forwards or backwards in the 
recording.

■ Contact Information—Displays the evaluation form header data for the 
recorded contact and any user-defined metadata associated with the contact. 
The data shown in this pane is configured by the administrator. You can edit 
the user-defined metadata. 

■ Evaluation Form—Displays the form used to evaluate the contact. Only 
evaluators can complete the form; all other roles can only review it.

Figure 7. Evaluation View window

Recording Selection tree

Playback pane

Evaluation Form 

Contact Information 

Playback Controls 

Form Controls/

Form Comments

Section Comments

(Advanced level only)

Approval
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■ Form Controls—Enables you to tag the evaluation as an HR or Training 
contact, mark the evaluation as complete or as approved, and to save any 
changes made to the evaluation. 

■ Form Comments—The Add button in this section enables you to add a general 
comment about the contact. The Read button pops a window containing all 
form comments entered for the contact.

■ Section Comments—The Add button in this section enables you to add a 
comment specific to the form section you have selected in the Evaluation 
Form pane. The Read button displays a popup window containing all 
comments entered for the selected form section. 
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Reports Tab

The Reports tab switches you to your web browser, where a list of reports available to 
you are listed. From there you are able to display and print performance reports in a 
number of formats. The formats available are as follows:

■ Acrobat PDF—Reports in PDF format can be viewed and printed from Adobe 
Acrobat Reader version 6.0 or higher. The free Adobe Acrobat Reader is 
available for downloading from www.adobe.com. 

■ CSV—Reports in CSV (comma separated values) format can be copied and 
pasted into a spreadsheet or word processing program for further 
manipulation. Note that there may be minor differences between the CSV 
reports and the HTML/PDF reports due to limitations of the file format.

■ HTML—Reports in HTML format can be viewed and printed from your web 
browser. 

■ XLS–Reports in XLS format can be viewed and printed from Microsoft Excel.

The reports available for viewing depend on your role. Table 8 shows which reports are 
available to each role.

Table 8. QM Desktop reports 

Report Type Report Mgr Spvr Agent KW

Agent*

* Knowledge workers view Agent Reports—the roles are equivalent.

Agent Scored Evaluation × × × ×

Agent Section Scores × × × ×

Agent Trend × × × ×

Archive Archive System Access Patterns ×

Audit Trail Access Report ×

Enterprise Enterprise’s Group Average Scores ×

Evaluation Evaluator Performance ×

Group Group’s Agent Average Scores ×

Group’s Team Average Score ×

Group’s Team Section Scores ×

Status User Recording Status × ×

System Status ×

Team Team’s Agent Average Scores × ×

Team’s Agent Section Scores × ×
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To generate a report:

1. On the QM Reporting System page, click the hyperlinked name of the report 
you want to view.

Search criteria fields appear to the right of the list of reports.

2. Complete the search criteria fields and specify the format you want, and then 
click Continue.

The report is generated and displayed in the format you selected.

NOTE:  Reports are displayed in a new browser window. If your 
browser has a popup blocker enabled, you must disable it before the 
report can be displayed.

Report Descriptions

NOTE:  QM Desktop rounds up scores for individual sections in 
evaluation forms. However, in reports that show section averages for 
agents, teams, and groups, the section scores are first added and 
averaged before being rounded up. As a result, the average displayed 
in reports will vary slightly from the number calculated by adding up 
section scores as displayed in QM Desktop and then averaging them. 

Agent Scored Evaluation Report

This report displays the details of all evaluations made of a specific agent or 
knowledge worker during a specified time period, including the scores given on each 
evaluation question, the score for each section, the overall score, and any added 
comments. 

Table 9. Agent Scored Evaluation Report Fields 

Field Description

Contact ID The recording contact’s ID.

Called Number The number of the phone that received the call.

Calling Number The number of the phone that made the call.

Contact Date The date the contact was recorded.

Call Duration The contact’s talk time (length of time between call 
answered and call dropped).

Eval Date The date the contact was evaluated.

Evaluator The name of the person who evaluated the contact.
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Agent Section Scores Report

This report displays the average score for a specific agent or knowledge worker for 
each section of an evaluation form over a specified time period. The averages can be 
of scores from multiple evaluations using the same form.

Agent Trend Report

This report displays a specific agent’s or knowledge worker’s average score for each 
evaluation made over a specified time period, along with an indicator if that score 
meets, exceeds, or is below expectations for that form. 

Eval Form The evaluation form used to score the contact.

Score Type The evaluation’s scoring method: Yes/No or 1–5.

Score (%) The evaluation’s score.

Table 10. Agent Section Scores Report Fields 

Field Description

Total Evaluations The total number of evaluations during the specified 
time period using the specified evaluation form.

Section The section title.

Section Average The average score the agent received for the section on 
all evaluations during the specified time period.

Table 11. Agent Trend Report Fields 

Field Description

Contact Date The date the contact was recorded.

Call Duration The contact’s talk time (length of time between call 
answered and call dropped).

Form The form used to evaluate the contact.

Weighted Percent The total weighted percent score for the evaluation.

Exceed An X indicates the evaluation exceeds expectations.

Meet An X indicates the evaluation meets expectations.

Below An X indicates the evaluation is below expectations.

Table 9. Agent Scored Evaluation Report Fields — Continued

Field Description
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Archive System Access Patterns Report

This report displays a list of archived recordings that were reviewed over a specified 
period. It enables you to determine if a significant number of recordings concerning a 
particular agent, called number, or calling number were reviewed.

Audit Trail Access Report

This report displays which users accessed the archives over a specified period. 

Table 12. Archive System Access Patterns Report Fields 

Field Description

Access Date The date the contact was accessed.

Contact ID The ID of the contact accessed.

Contact Date The date the contact was recorded.

Calling Number The number of the phone that made the call.

Called Number The number of the phone that received the call.

Table 13. Audit Trail Access Report Fields 

Field Description

Accessed By The name of the person who accessed the archives.

User ID The Windows login (and domain, if an Active Directory 
system) of the person who accessed the archives.

Access Date The date the specified contact was accessed.

Agent The name of the agent associated with the contact.

Agent ID The agent’s ID.

Contact Date The date the contact was recorded.

Calling Number The number of the phone that made the call.

Contact ID The ID of the contact that was accessed.
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Enterprise’s Group Average Scores Report

This report displays a summary of the evaluation points and average scores for each 
group within the enterprise over a specified time period.

Evaluator Performance Report

This report provides a summary of all evaluators’ productivity by displaying the 
number of evaluations they have performed over a specified time period, and the 
average score they have awarded to those evaluations.

Table 14. Enterprise’s Group Average Scores Report Fields 

Field Description

Group The name of the group

Number of Teams The total number of teams assigned to the group during 
the specified time period.

Number of Agents The total number of agents assigned to the group during 
the specified time period.

Total Evaluations The total number of evaluations made for agents in the 
group.

Group Average The average score of all contacts evaluated for agents in 
the group.

Score Std Dev The score standard deviation, calculated from all 
evaluations in the group.

Total Exceed The total number of evaluated contacts whose scores 
exceed expectations. The default score range is 
90–100%. This range can be modified by the 
administrator.

Total Meet The total number of evaluated contacts whose scores 
meet expectations. The default score range is 75–89%. 
This range can be modified by the administrator.

Total Below The total number of evaluated contacts whose scores 
fall below expectations. The default score range is 
0–74%. This range can be modified by the 
administrator.

Table 15. Evaluator Performance Report Fields 

Field Description

Evaluator The name of the evaluator.
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Group’s Agent Average Scores Report

This report displays the average evaluation score for each agent on each team in the 
group, and the group’s average evaluation score and total evaluations. 

User ID The evaluator’s Windows login ID (and domain, if an 
Active Directory system).

Total Evaluations The total number of evaluations performed by the 
evaluator over the specified period.

Average Score The average score of the evaluations performed by the 
evaluator over the specified period.

Table 16. Group’s Agent Average Scores Report Fields 

Field Description

Team The name of the team.

Agent The name of the agent.

Agent ID The agent’s ID.

Total Evaluations The total number of evaluations performed on the agent.

Agent Average The average evaluation score of all the agent’s 
evaluations.

Score Std Dev The score standard deviation, calculated from all 
evaluations for the agent.

Total Exceed The total number of evaluated contacts whose scores 
exceed expectations. The default score range is 
90–100%. This range can be modified by the 
administrator.

Total Meet The total number of evaluated contacts whose scores 
meet expectations. The default score range is 75–89%. 
This range can be modified by the administrator.

Total Below The total number of evaluated contacts whose scores 
fall below expectations. The default score range is 
0–74%. This range can be modified by the 
administrator.

Table 15. Evaluator Performance Report Fields — Continued

Field Description
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Group’s Team Average Scores Report

This report displays a summary of the evaluation points and average scores for each 
team within the group over a specified time period, and the group’s average 
evaluation score and total evaluations.

Group’s Team Section Scores Report

This report enables a manager to compare average section scores on a particular 
evaluation form for each team in the group over a specified time period. The scores 
for each team are the average of all the scores given to all agents in each group on all 
evaluations performed over the time period specified.

Table 17. Group’s Team Average Scores Report Fields 

Field Description

Team The name of the team.

Team ID The team ID.

Total Evaluations The total number of evaluations performed on the 
team’s agents.

Team Average The average evaluation score of all the team’s 
evaluations.

Score Std Dev The score standard deviation, calculated from all 
evaluations for the team.

Total Exceed The total number of evaluated contacts whose scores 
exceed expectations. The default score range is 
90–100%. This range can be modified by the 
administrator.

Total Meet The total number of evaluated contacts whose scores 
meet expectations. The default score range is 75–89%. 
This range can be modified by the administrator.

Total Below The total number of evaluated contacts whose scores 
fall below expectations. The default score range is 
0–74%. This range can be modified by the 
administrator.

Table 18. Group’s Team Section Scores Report Fields 

Field Description

Team The name of the team.

Number of Agents The total number of agents assigned to the team during 
the specified time period.
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User Recording Status

This report displays a history of the status of agents’ QM Desktop Recording services 
at the team level or group level, depending on your role. It also logs when metadata 
added by a particular agent fails to be added due to invalid key or format for a date or 
number.

You can choose to view messages generated by the service at the INFO, WARN, or 
ERROR level, or at all levels. Information is available for the past 7 days, including the 
current day. 

System Status

This report displays system and administrative events associated with agents’ 
QM Desktop Recording services, Upload Controller services, and the File Transfer 
service (FTS). You can choose to view messages generated by the service at the INFO, 
WARN, or ERROR level, or at all levels. Information is available for the past 7 days, 
including the current day.

Total Evaluations The total number of evaluations performed on the 
team’s agents over the specified time period.

Section The name of the evaluation form section.

Section Average The average score given to all agents on the team for 
the section.

Table 19. User Recording Status Report Fields 

Field Description

Team The name of the team.

Agent The name of the agent.

Agent ID The agent’s ID.

Machine The name of the computer on which the event occurred.

IP Address The IP address of the computer on which the event 
occurred.

Date The time and date of the event.

Level The level of the event (INFO, ERROR, WARN).

Category The service associated with the event.

Message The event message.

Table 18. Group’s Team Section Scores Report Fields — Continued

Field Description
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The File Transfer service writes events that warn when free space is low on the voice 
and screen servers server or when uploads stop because free space is too low.

Team’s Agent Average Scores Report

This report displays the average evaluation score for each agent on a team, and the 
team’s overall average evaluation score. 

Table 20. System Status Report Fields 

Field Description

Date The time and date of the event.

Machine The name of the computer on which the event occurred.

IP Address The IP address of the computer on which the event 
occurred.

Level The level of the event (INFO, ERROR, WARN).

Category The application associated with the event. 

Message The event message.

Table 21. Team’s Agent Average Scores Report Fields 

Field Description

Agent The name of the agent.

Agent ID The agent’s ID.

Total Evaluations The total number of evaluations performed on the agent 
over the specified time period.

Agent Average The average evaluation score of the agent’s evaluations 
over the specified time period.

Score Std Dev The score standard deviation, calculated from the 
evaluations for the agent over the specified time period.

Total Exceed The total number of evaluated contacts over the 
specified time period whose scores exceed 
expectations. The default score range is 90–100%. This 
range can be modified by the administrator.

Total Meet The total number of evaluated contacts over the 
specified time period whose scores meet expectations. 
The default score range is 75–89%. This range can be 
modified by the administrator.
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Team’s Agent Section Scores Report

This report displays the average section scores on a particular evaluation form for 
each agent on a team.

Total Below The total number of evaluated contacts over the 
specified time period whose scores fall below 
expectations. The default score range is 0–74%. This 
range can be modified by the administrator.

Table 22. Team’s Agent Section Scores Report Fields 

Field Description

Agent The name of the agent.

Agent ID The agent’s ID.

Total Evaluations The total number of evaluations performed on the agent 
for the specified evaluation form over the specified time 
period and while the agent was on this team.

Section The name of the evaluation form section.

Section Average The average score given to the agent for the section.

Table 21. Team’s Agent Average Scores Report Fields — Continued

Field Description
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Archives Tab

If archiving is enabled by the QM administrator, contact recordings can be saved for 
periods of one year or longer. The administrator sets the length of time that recordings 
are archived, depending on how much storage space is available in your system. 

The minimum length of what is considered a valid archive recording is set at 5 
seconds and cannot be changed.

Information about contact recordings (metadata) is available in the archives 
immediately after a call is recorded, even though the contact recording itself has not 
yet been uploaded from the client desktop to the voice server. If such a contact must 
be reviewed immediately, the voice recording is uploaded on-demand as long as the 
client desktop is on and available. 

The Archives tab (Figure 8) enables you to search the stored archives for specific 
contact recordings. 

The archive recordings are audio only, and are independent of contact recordings 
made according to configured workflows set up by the administrator. 

The Archives tab is visible only to users with the role of supervisor, manager, evaluator, 
or archive user. Supervisors have access to archived contacts made by 
currently-active agents on their currently-active assigned teams; managers have 

Figure 8. Archives tab, showing the result of a search

Search criteria Audio player controls Contact information/metadata

Search results
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access to archived contacts made by currently-active agents of their currently-active 
assigned groups. Archive users and evaluators have access to all contacts.

Searching the Archives

To find a contact recording in the archives, search by contact date range and any one 
or all of the other available search criteria.

NOTE:  Your search will be faster if you include the agent’s name as 
part of your search criteria. 
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Figure 9 shows an example of typical search criteria.

Your search can be either a one-step process or a two-step process.

■ In the one-step process, you search for contacts only.

■ In the two-step process, you first search for agents and then search for a 
particular agent’s contacts.

The two-step process is the fastest way to locate a contact. 

Figure 9. An example of a search using the required date range, the first 3 letters of the 
agent’s last name and a wild card, and then metadata
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Any search you run can return a maximum of 3000 results. If the search exceeds 
3000 results, you will see a message asking you to narrow the date range of your 
search.

The search criteria fields are defined in Table 23. 

One-Step Search Process

To search the archives for a contact recording using the one-step process:

1. Enter the start and end date of the period during which the contact occurred. 
By default these values are yesterday’s date (start date) and today’s date (end 
date). 

Table 23. Archive search criteria fields 

Field Description*

* All search criteria fields except Start Date, End Date, and Metadata Field accept any defined 
unicode character, plus wild cards (? and *). A defined unicode character is any character that can 
be typed on your keyboard.

First Name The agent’s first name. 

Last Name The agent’s last name. 

Agent Tagged Select the check box to search for contacts that the 
agent has tagged to be saved, using a third-party API.

Metadata Field A drop-down list that contains all unencrypted metadata 
fields that have been defined by the administrator. You 
cannot search encrypted metadata fields.

Metadata Search Search string for contents of the selected metadata 
field. The format for this field is determined by the 
format of the selected metadata field: a date, a number, 
or text.

Start Date Automatically filled with yesterday’s date. Select the 
desired date using the calendar button or entering the 
date in <Month> <day>, <year> format.

End Date Automatically filled with today’s date. Select the desired 
date using the calendar button or entering the date in 
<Month> <day>, <year> format.

Phone A phone number that is part of the contact’s enterprise 
data (calling number or called number). NOTE: Some 
calling numbers are private and are put into the 
database as “unknown”. You can enter unknown in this 
field to search for these customer contacts.
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2. Enter any one or all of the these search criteria:

■ Agent Tagged

■ Metadata Field and Metadata Search

■ Phone

3. Click Find Contacts.

A list of the contacts that were made during the date range you selected by 
agents who were active at that time, and that fit your other search criteria, is 
displayed in the Contacts pane. If you are a manager or supervisor, the agents 
will be only those who currently belong to your group or team.

Two-Step Search Process

To search the archives for a contact recording using the two-step process:

1. Enter the start and end date of the period during which the contact occurred. 
By default, these values are yesterday’s date (start date) and today’s date 
(end date).

2. Enter all or part of the first and/or last name of the agent whose contacts you 
want to find, and then click Find Agents.

A list of agents who were active during the time period you selected and 
whose names fit your search criteria is displayed in the Agents pane. If you are 
a manager or supervisor, the agents will be only those who currently belong to 
your group or team.

3. Select the desired agent’s name from the list of results, and then enter any or 
all of these search criteria:

■ Agent Tagged

■ Metadata Field and Metadata Search

■ Phone

4. Click Find Contacts.

A list of the selected agent’s contacts that fit your search criteria is displayed 
in the Contacts pane.

Clearing the Search Results

To clear your search results, click the Clear button in the top portion of the left pane. 

Playing Contact Recordings

Once you have found a contact using a one-step or two-step search, double-click the 
contact in the right pane. The recording is loaded and starts playing. Information 
about the contact is displayed in the Contact Information pane.
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You can move forward and backward through the list of contacts using the call control 
buttons (Figure 10). 

If nothing is selected in the list of contacts:

■ Click the Previous button to select and play the last contact in the list.

■ Click the Play or Next button to select and play the first contact in the list.

Editing Contact Metadata

User-defined metadata, if any, is displayed in the Contact Information pane. You can 
add, edit, and delete this metadata. 

To add, edit, or delete user-defined metadata:

1. In the selected contact’s Contact Information pane, double-click the metadata 
field you want to edit.

The Edit Metadata for <metadata> dialog box appears.

2. Add new metadata, or edit or delete the existing metadata in the dialog box, 
and then click OK.

3. Click Save. 

Figure 10. Associated contacts call control buttons

Figure 11. Edit Metadata for <metadata> dialog box

Stop current contact

Play next contact

Play current contact

Play previous contact
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Playing All Segments of a Call

You can play all segments of a call from when it enters the contact center to when it is 
terminated, using the Associated Contacts feature. 

Once you have searched for and found a contact, clicking the Associated Contacts 
button enables you to see every call segment associated with that contact listed in the 
Contacts pane. 

An example of the segments of a call is:

1. Customer dials in and is routed to Agent A

2. Agent A transfers customer to Agent B

3. Agent B conferences call with Supervisor A

The list of associated contacts is presented in chronological order in the Associated 
Contacts window (Figure 12), with the original contact highlighted. Some of the 
contacts listed might not be able to be played back. This is due to various reasons: 
they are for agents not on your team; they were deleted; they didn’t meet workflow 
criteria; or they were under the minimum length. These segments are listed in red. You 
cannot listen to those segments of the call, but you can view them so that you can 
follow how the call moved through the contact center. When you use the call control 
buttons to move through the list of contacts, it automatically skips over contacts you 
cannot listen to (those displayed in red). 

Figure 12. Associated contacts window
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Exporting Contact Recordings

QM can be configured by the administrator so that users can export contact 
recordings by saving them in one of the following formats:

■ WMA (compressed audio files)

■ WAV (uncompressed audio files)

■ WMV (compressed audio/video files)

By default, the export feature is disabled.

Recordings can be exported from the Recording tab and the Archives tab. When a 
recording is selected for export, all available data connected with the recording—
audio, video, and metadata—are included in the exported file (except WAV files, which 
cannot include metadata).

Exported recordings can be played using Microsoft Windows Media Player 9 or newer.

The time needed to export a recording depends on the length of the recording and 
whether it includes video. If a recording is in the process of being exported and the 
QM Desktop session times out, the export process will continue to completion. 

NOTE:  Multiple audio-only recordings can be exported 
simultaneously. Audio/video recordings must be exported one at a 
time. If an audio/video recording is in the process of being exported, 
and you select another audio/video recording for export, the second 
recording will be queued to start export after the first recording export 
has completed. 

To export a contact recording:

1. Select the recording you want to export from the Recordings tab or from the 
Archives tab.

2. Choose File > Save Recording As from the menu bar, and specify a file name, 
file format, and location where you want the recording saved. By default, the 
recording file name is the contact ID. 

3. Click Save. The contact recording is saved to the selected location.

Viewing Exported Metadata

Call metadata is inserted into WMV and WMA files. Call metadata is not available in 
WAV files, since the WAV file format does not support tags.

The supported tags are displayed in the Windows Media Player Properties window, in 
the Description field on the Content tab. Only system metadata and metadata that is 
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enabled for export in QM Administrator is displayed. System metadata includes ID, 
ANI, DNIS, acdCallId, lastName, firstName, agentId, username, and startTime.

To view QM metadata in Window Media Player:

1. Launch Windows Media Player.

2. Select the desired exported recording file.

3. From the menu bar, choose File > Properties, and from the Properties window, 
select the Content tab. The metadata is displayed on the Content tab 
(Figure 13). 

Figure 13. QM metadata displayed in Windows Media Player
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Evaluating Contacts
Introduction

Contacts can be evaluated and scored by playing back contact audio and video 
recordings made during a call. The performance statistics available in the 
Dashboard and Reports windows are based on these evaluation scores.

General Procedure for Evaluating a Contact

The following is the general procedure for evaluating a contact.

To evaluate a contact:

1. Select the desired contact from the Unscored or In Progress folders in the 
navigation tree.

2. Score the contact, and add comments and tags as needed.

■ If you cannot complete the evaluation at this time, click Save to save 
it to the In Progress folder. The evaluation can be continued at a later 
time.

3. When the evaluation is complete, click Save and then Complete. If the 
evaluation must be approved, it is moved to the Needs Approval folder. If 
no approval is required, it is moved to the Scored folder.

The following sections of this chapter discuss these steps in more detail.
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Folders in the Recordings Navigation Tree

There are 4 folders in the Recordings tab navigation tree. These folders contain all 
contacts that are in the process of being evaluated. Table 24 details which contacts 
are in each folder.

Table 24. Recordings tab folders

Folder Contact Description

Unscored Contacts that are as yet unclaimed by an evaluator and 
unscored.

In Progress Contacts that are claimed by an evaluator but which are 
not yet completely scored.

Needs Approval Contacts that are claimed by an evaluator, are fully 
scored, and are awaiting approval.

Scored Contacts that are claimed, fully scored, and, if approval 
is required, are approved.
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Evaluating a Contact

The first step an evaluator takes is to select and display a contact recording.

To select and display a contact recording:

1. In the navigation tree, click the drop-down list to select the way you wish the 
contact recordings to be sorted. 

2. Expand the resulting folders as necessary.

Recordings belonging to the group, team, agent, or knowledge worker 
(depending on how you sort the navigation tree) are listed in the Contacts 
pane in alphabetical order.

3. In the Contacts pane, double-click the contact recording you want to evaluate.

The contact opens in the Evaluation View pane.

NOTE:  To ensure that the navigation tree displays all current contact 
recordings, click the Refresh button at the bottom of the navigation 
tree pane. 

When the navigation tree is first displayed, the folders are a dark gray. As you expand 
the folders and display lists of contacts in the Recording View pane, the folders turn 
yellow. This indicates that the contact metadata—information about each contact 
such as the agent’s name, the time and date of the contact, and so on—is now cached 
in your computer’s memory.

Evaluating an Agent-Tagged Recording

A contact that was recorded because an agent tagged it for retention displays 
“Tagged” in the Reason column on the Recordings window. These recordings do not 
have an evaluation form associated with them until the first person who evaluates 
them assigns one.

To assign an evaluation form to an agent-tagged recording:

1. In the Contacts pane, double-click the agent-tagged recording.

The contact opens in the Evaluation View pane. There is no evaluation form 
associated with the contact, so the bottom portion of the pane is blank.

2. Directly below the playback pane is a drop-down list from which you can 
select any active evaluation form. Select the desired active form.

3. Score and save the evaluation.

When you have scored and saved the evaluation, that form is permanently 
associated with the contact and cannot be changed.
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Playing a Recording

When the Evaluation View pane is displayed, the evaluation form and the contact 
information is visible and the audio portion of the contact starts downloading. Click 
the Start button in the Playback Control pane to start the recording.  

When you click the Start button, the video portion of the recording starts streaming 
from the Screen Service server. The audio starts playing several seconds into the 
recording (the contact information might indicate exactly when the audio starts).

NOTE:  Video is available only with the Advanced version of QM.

It is possible for the audio and video streams to fall out of sync on rare occasions. If 
this happens, you will receive an error message. Stop and then restart the playback to 
resync the audio and video. If that does not work, click the Cancel button and exit the 
evaluation form, then open it again and start over.

The volume slider works within the constraints of your PC’s system volume. If the 
system volume is set to zero, the QM volume slider will not be able to turn the volume 
up. If the system volume is set to 50%, the QM volume, even when maximized, will 
only increase the volume to a maximum of 50%.

Video Recording Playback

You can control the size of the video recording when you view it. By default, the video 
recording is displayed so that it fits in the playback pane and the aspect ratio (4:3 or 
16:9) is maintained. If you adjust the size of the playback pane, the recording will 
resize accordingly. 

If you want to view the recording at the resolution at which it was recorded, select the 
Fit 1 to 1 option in the lower right corner of the playback pane. This will resize the 
recording so that it is actual size. Use the scroll bars to view the entire recording. 

To return to the default view, select the Fit to Window option. The recording will resize 
so that the entire recording is visible within the playback pane.

Figure 14. Playback controls

Before playback During playback

Start Pause StopVolume Control
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Single- and Dual-Monitor Recordings

The Evaluation View window can display recordings of both single- and dual-monitor 
setups. Figure 15 shows the Evaluation View window playing a recording of a 
dual-monitor setup.  

You can zoom in on the recording by selecting the Fit 1 To 1 option and using the 
scroll bars to move around the window.

Bracketed and Interleaved Call Recordings

When an agent or knowledge worker handles two calls simultaneously by putting one 
on hold and switching between them, the result can be either one or two recordings, 
depending on if the calls are bracketed or interleaved.

Figure 15. Dual-monitor recording
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In Figure 16, Recording 1 is created for Call 1. It also contains the entire audio from 
Call 2. Call 2 is bracketed within Call1.

In Figure 17, Recording 1 is created for Call 1. It will also contain the portion of audio 
from Call 2 during the time when both calls are active. Recording 2 is created for Call 
2 when Call 1 ends. Recording 2 only contains the portion of audio from Call 2 from 
the time Call 1 ends. Call 1 is interleaved with Call 2. The duration reported for Call 2 
is from the time when Call 2 starts until the time that Call 2 ends. However, the actual 
duration of Recording 2 will be from the time Call 1 ends until the time Call 2 ends.

Completing the Evaluation Form

To complete an evaluation form, select the appropriate score button for each question 
on each section of the form. 

■ You can select only one score per question.

■ If you elect to leave the form before you have completed the evaluation, click 
Save to mark the form as In Progress.

■ Once the evaluation is saved and completed, only the original evaluator can 
modify the evaluation scoring. If for some reason Evaluator A is no longer 
available and Evaluator B must take over Evaluator A’s evaluations, Evaluator 
B must log in as Evaluator A. 

Only an administrator can create a form. A form can use either a Yes/No or scale of 
0–5 method of scoring. There can be up to 10 sections in a form, and each section 
can contain up to 10 questions.

Figure 16. Bracketed call

Figure 17. Interleaved calls
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Key Performance Indicator (KPI) Questions

The administrator who creates the evaluation form might designate some questions 
as “key performance indicator” (KPI) questions (Figure 18). A poor score on a KPI 
question (“no” on a Yes/No question or “zero” on a 0–5 question) results in a zero 
score for the entire evaluation, no matter how the agent scores on other questions. 

You still must continue to score the entire evaluation when a KPI question triggers a 
final zero score. The scores you assign to all questions and sections are retained and 
are available for review. 

Adding Comments to the Evaluation

Evaluators, managers, and supervisors can add comments to an evaluation either 
while they are scoring it, or after they have completed scoring the form. Agents can 
add comments to an evaluation only after the evaluation has been scored.

There are two types of comments:

■ Form comments—comments that apply to the entire evaluation

■ Section comments—comments that apply to a specific section 

The Read button in the Form Comments and Section Comments pane is enabled 
when comments are saved for the form or for a specific section. When you click the 
Read button a popup window containing the comments already entered is displayed 
(Figure 19).

NOTE:  You must select a section to see the comments for that 
section. If there are no comments for a section, the Read button is 
disabled.

Figure 18. Evaluation form with a KPI question shown

Scoring a zero on this Key Performance Indicator question 
results in a zero score for the entire evaluation.
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Comments are not added to the Read Comments window until you save them. If you 
enter a comment in the Add Comment window but do not save it, the next time you 
click Add that comment will still be visible in the Add Comment window. 

In the Read Comments window, each comment is identified with the name and role of 
the person who entered the comment and the date and time it was entered. 

When you select a comment it is highlighted in yellow. You can select the text of a 
comment and use standard Windows commands to copy and paste it into another 
application.

An evaluation’s comments are also available for viewing and printing in the Agent 
Scored Evaluation report. See "Reports Tab" on page 31 for more information.

NOTE:  Each comment can be up to 1300 characters, and the total of 
all comments can be up to 65,000 characters. 

To add a general (form) comment:

1. In the Form Comments pane, click Add to display the Add Comment dialog 
box.

2. Type your comment and then click OK to close the dialog box.

3. Click Save to save your comment.

To add a section comment:

1. Select the section of the evaluation form you wish to comment on.

Figure 19. Sample Read Comments window
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2. In the Section Comments pane, click Add to display the Add Comment dialog 
box.

3. Type your comment and then click OK to close the dialog box.

4. Click Save to save your comment.

NOTE:  Section comments might or might not be enabled on this form. 
This functionality is configured by the administrator who created the 
form.

Tagging the Evaluation for Training or HR

The “Training” tag is added to a recording that the evaluator, supervisor, or manager 
decides can serve as a training example. By default, any recording with a Training tag 
is kept indefinitely and can be viewed by any role. The retention time is configured by 
the administrator. The evaluator, supervisor, or manager can remove a Training tag 
from a recording. 

The “HR” (Human Resources) tag is added to a recording that an evaluator or 
supervisor decides should be reviewed by Human Resources for some reason. By 
default, any recording with an HR tag is kept for 180 days. The retention time is 
configured by the administrator. Only a supervisor or evaluator can remove an HR tag 
from a recording.

To tag an evaluation for Training or HR:

1. In the Form Controls pane, select the Training or HR check box, or both.

2. Click Save.

Editing Contact Metadata

User-defined metadata, if any, is displayed in the Contact Information pane. You can 
add, edit, and delete this metadata. 

To add, edit, or delete user-defined metadata:

1. In the Contact Information pane, double-click the metadata field you want to 
edit.
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The Edit Metadata for <metadata> dialog box appears.

2. Add new metadata, or edit or delete the existing metadata in the dialog box, 
and then click OK.

3. Click Save. 

Saving the Evaluation

You can save an evaluation at any time while you are working on it. The saved 
evaluation is moved to the In Progress folder. 

Only the evaluator who saved the evaluation can resume working on it. Other 
evaluators can view it, but the only change the other evaluators can make to the 
evaluation is to add comments and to add the Training/HR tags. 

Completing the Evaluation

When you are finished scoring the contact, adding comments, and tagging the 
evaluation with the HR or Training tag if needed, click the Save button to save the 
evaluation, and then the Complete button to mark it as complete. The completed 
evaluation is moved to the Scored folder if no approval is required, and to the Approval 
Needed folder if approval is required.

Approving the Evaluation

The administrator can configure QM so that evaluations must be approved by a 
manager, supervisor, and/or evaluator. The approval requirement is enabled on an 
evaluation form basis and for specific roles. By default, approval is not required.

Evaluations that require approval are listed in the Needs Approval folder in the 
navigation tree. You can approve only evaluations that are for agents on your team. 
The approver of an evaluation does not have to be different from the person who 

Figure 20. Edit Metadata for <metadata> dialog box
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scored the contact—you can evaluate a contact and then approve the evaluation 
yourself if you are configured to do so.

To approve an evaluation:

1. Select the Needs Approval folder in the navigation tree to display evaluations 
that need approval.

2. Double-click the desired evaluation to display it in the Evaluation View pane.

3. Review the evaluation. 

4. In the Form Control section of the window, click Approve or Reject, and then 
click Save.

■ If you click Approve, the evaluation is moved from the Needs Approval 
folder to the Scored folder. Once approved and saved, you cannot undo 
the approval.

■ If you click Reject, a comment window appears. Add a comment 
explaining why the evaluation is rejected. When the comment is saved, 
the evaluation is moved to the In Progress folder so that it can be 
amended.

NOTE:  If an evaluator makes a change to an evaluation that has been 
approved, that evaluation is moved back to the Needs Approval folder. 

Understanding Evaluation Scoring

As the evaluator scores a section on an evaluation form, a rolling total and percent is 
displayed on that section. For example, Figure 21 shows a completed form with two 
sections. 

Section A has a possible total of 15 points. As the evaluator scores each question in 
the section, the total section score earned is displayed. In Figure 21, the agent has 
earned 9 out of the possible 15 points, or 60%.

Likewise, Section B has a possible total of 10 points and the agent has earned 8 
points, or 80%.
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The overall form score for the evaluation is displayed in the gray area at the top of the 
form. These numbers are calculated as each section is completed. 

Section Weighting

The administrator who set up the evaluation form shown in Figure 21 determined that 
Section A would contribute 40% towards the evaluation score and Section B would 
contribute 60%. The section weighting is indicated on each section tab.

These weightings are applied after all sections are scored to arrive at the weighted 
percent score for the evaluation. 

The weighted percent is calculated as follows:

Section percent × section weight = section weighted percent

Sum of all section weighted percents = total weighted percent

In this example:

Section A = 60% × 0.4 = 24%

Section B = 80% × 0.6 = 48%

24% + 48% = 72% weighted percent

Figure 21. Sample scored evaluation form

Score for the 
entire form

Scores for 
each section
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